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Obtaining Help while Working in PowerPoint
To Obtain Help Using the Tell Me Box
To Sign Out of a Microsoft Account
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
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MODULE TWO

Enhancing Presentations with Shapes
and SmartArt
Objectives
Introduction
Project—Presentation with SmartArt and Shapes
Downloading a Theme and Editing Slides
To Search for and Download an
Online Theme
To Save the Presentation
To Delete a Slide
To Create a Title Slide
To Align a Paragraph
To Create the First Text Slide
To Insert a Symbol
To Copy a Symbol
To Add a Hyperlink to a Paragraph
Creating and Formatting a SmartArt Graphic
To Convert Text to a SmartArt Graphic
To Edit SmartArt Shape Text
Text Pane
To Edit SmartArt Bulleted Text
To Format Text Pane Characters
To Change the SmartArt Layout
To Edit the Title Text
To Duplicate a Slide
To Insert a SmartArt Graphic
To Add Text to the SmartArt Graphic
To Apply a SmartArt Style
Inserting and Formatting a Shape
To Insert a Shape
Resizing Shapes
To Resize a Shape Proportionally
To Resize a Shape Nonproportionally
by Entering an Exact Measurement
To Select All Slide Content
To Apply a Shape Style
To Copy and Paste a Shape
To Add Text to a Shape
To Select Shapes
To Format Shape Text
To Change a Shape Fill Color
Positioning Slide Elements
Aligning and Distributing Objects
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To Display the Ruler
To Display the Gridlines
To Position a Shape Using Guides,
Gridlines, and the Ruler
To Position the Remaining Shapes
To Distribute Shapes
To Align a Shape
To Position the Arrow Shape
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Adding a Footer
To Add a Footer with Fixed Information
Adding a Transition
To Add a Transition between Slides
To Save and Print the Presentation
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Extend Your Knowledge
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MODULE THREE
Inserting WordArt, Charts, and Tables

Objectives
Introduction
Project—Presentation with WordArt, a Chart,
and a Table
Adding a Chart to a Slide and Formatting
To Run PowerPoint, Apply a Theme, and
Save the Presentation
To Delete a Placeholder
To Insert a Chart
To Replace Sample Data
To Resize a Chart
To Align a Chart
To Change a Chart Style
To Change the Shape Outline Color
To Change the Shape Outline Weight
To Change the Title and Legend Font
and Font Size
Adding a Table to a Slide and Formatting
Tables
To Insert an Empty Table
To Enter Data in a Table
To Apply a Table Style
To Add Borders to a Table
To Add an Effect to a Table
To Insert a Table Row
To Insert a Table Column
To Resize a Table
To Align a Table
To Add a Slide Title
Inserting and Formatting a Text Box
To Insert a Text Box and Format Text
To Format Text Box Characters
Inserting and Moving Slides
To Reuse Slides from an Existing
Presentation

PPT 2-44
PPT 2-44
PPT 2-45
PPT 2-46
PPT 2-47
PPT 2-48
PPT 2-48
PPT 2-49
PPT 2-50
PPT 2-51
PPT 2-52
PPT 2-52
PPT 2-53
PPT 2-54
PPT 2-54
PPT 2-55
PPT 2-55
PPT 2-56
PPT 2-57
PPT 2-59
PPT 2-59
PPT 2-60
PPT 2-63
PPT 2-64
PPT 2-66

PPT 3-1
PPT 3-1

PPT 3-1
PPT 3-3

PPT 3-3
PPT 3-4
PPT 3-5
PPT 3-6
PPT 3-8
PPT 3-9

PPT 3-10

PPT 3-11

PPT 3-12

PPT 3-13
PPT 3-13
PPT 3-14
PPT 3-14
PPT 3-15
PPT 3-16
PPT 3-17
PPT 3-18
PPT 3-19
PPT 3-20
PPT 3-21
PPT 3-22
PPT 3-23
PPT 3-23
PPT 3-23
PPT 3-24
PPT 3-26

PPT 3-27

To Move a Slide in Slide Sorter View
Inserting Pictures and Adding Effects
To Delete a Picture
To Insert and Resize a Picture into a
Slide without Content Placeholders
To Crop a Picture
Adjusting Picture Colors
To Color a Picture
To Add an Artistic Effect to a Picture
To Change the Picture Softness
To Apply a Picture Style
To Size a Picture
To Move a Picture
To Align Pictures
Creating and Formatting WordArt
To Insert WordArt
To Change the WordArt Shape
To Change the WordArt 3-D
Rotation Effect
To Change the WordArt Text Fill Color
To Change the WordArt Text
Outline Color
To Convert Text to WordArt
To Resize WordArt Proportionally
Animating Slide Content
Custom Animations
To Animate an Object Using an
Entrance Effect
To Change Animation Direction
To Change the Animation Start Option
To Preview an Animation Sequence
To Change the Animation Duration
To Animate Text
To Change the Animation Sequence
Effect Option
Adding Media to Slides
To Insert a Video File
To Resize a Video Clip
To Move a Video Clip
To Change Video Contrast
To Play a Video File Automatically
To Add a Transition between Slides
To Run a Slide Show with Animations
and Video
To Save and Print the Presentation
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
In the Lab

MODULE ONE

Creating a Worksheet and a Chart
Objectives
Introduction

Project: Real Estate Budget Worksheet and Chart

Starting and Using Excel
What Is Excel?
To Start Excel and Create a Blank Workbook
The Excel Window
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microsoft EXCel 2019

EX 1-1
EX 1-1
EX 1-1
EX 1-4
EX 1-4
EX 1-5
EX 1-7

Copyright 2020 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s).
Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.



To Display a Different Tab on the Ribbon
Selecting a Cell
Entering Text
To Enter the Worksheet Titles
AutoCorrect
To Enter Column Titles
To Enter Row Titles
Entering Numbers
To Enter Numbers
Calculating Sums and Using Formulas
To Sum a Column of Numbers
Using the Fill Handle to Copy
a Cell to Adjacent Cells
To Copy a Cell to Adjacent Cells in a Row
To Calculate Multiple Totals at the Same Time
Calculating Average, Maximum, and Minimum
Values
To Enter a Formula Using the Keyboard
To Copy a Cell to Adjacent Cells in a
Row Using the Fill Handle
Saving the Project
To Save a Workbook
Formatting the Worksheet
Font Style, Size, and Color
To Change a Cell Style
To Change the Font
To Apply Bold Style to a Cell
To Increase the Font Size of a Cell Entry
To Change the Font Color of a Cell Entry
To Center Cell Entries across Columns
by Merging Cells
To Format Rows Using Cell Styles
To Format Numbers in the Worksheet
To Adjust the Column Width
To Use the Name Box to Select a Cell
Other Ways to Select Cells
Adding a Pie Chart to the Worksheet
To Add a Pie Chart
To Apply a Style to a Chart
Changing the Sheet Tab Names and Colors
To Move a Chart to a New Sheet
To Change the Sheet Tab Name and Color
Document Properties
Printing a Worksheet
To Preview and Print a Worksheet
in Landscape Orientation
Viewing Automatic Calculations
To Use the AutoCalculate Area to
Determine a Maximum
Correcting Errors
Correcting Errors while Entering Data
into a Cell
Correcting Errors after Entering Data into a Cell
Undoing the Last Cell Entry
Clearing a Cell or Range of Cells
Clearing the Entire Worksheet
Using Excel Help
To Obtain Help Using the Search Text Box
Obtaining Help while Working in an Office App
To Obtain Help Using the Tell Me Box
To Save a Workbook with a Different File Name
To Sign Out of a Microsoft Account

EX 1-12
EX 1-12
EX 1-12
EX 1-13
EX 1-15
EX 1-15
EX 1-17
EX 1-18
EX 1-18
EX 1-20
EX 1-20

EX 1-21
EX 1-22
EX 1-24

EX 1-25
EX 1-26

EX 1-27
EX 1-27
EX 1-28
EX 1-30
EX 1-32
EX 1-32
EX 1-34
EX 1-35
EX 1-36
EX 1-37

EX 1-38
EX 1-39
EX 1-41
EX 1-42
EX 1-44
EX 1-44
EX 1-45
EX 1-46
EX 1-48
EX 1-49
EX 1-49
EX 1-50
EX 1-51
EX 1-52

EX 1-53
EX 1-56

EX 1-56
EX 1-57

EX 1-57
EX 1-57
EX 1-59
EX 1-59
EX 1-60
EX 1-60
EX 1-61
EX 1-63
EX 1-63
EX 1-64
EX 1-64
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Summary

Apply Your Knowledge
Extend Your Knowledge
Expand Your World

In the Lab

MODULE TWO

Formulas, Functions, and Formatting
Objectives
Introduction
Project: Worksheet with Formulas and Functions
Entering the Titles and Numbers into the Worksheet
To Enter the Worksheet Title and Subtitle
To Enter the Column Titles
To Enter the Salary Data
Flash Fill
To Use Flash Fill
To Enter the Row Titles
To Change the Sheet Tab Name and Color
Entering Formulas
To Enter a Formula Using the Keyboard
Arithmetic Operations
Order of Operations
To Enter Formulas Using Point Mode
To Copy Formulas Using the Fill Handle
Option Buttons
To Determine Totals Using the AutoSum Button
To Determine the Total Tax Percentage
Using the AVERAGE, MAX, MIN, and other
Statistical Functions
To Determine the Highest Number in a
Range of Numbers Using the Insert
Function Dialog Box
To Determine the Lowest Number in a
Range of Numbers Using the Sum Menu
To Determine the Average of a Range
of Numbers Using the Keyboard
To Copy a Range of Cells across
Columns to an Adjacent Range Using
the Fill Handle
Verifying Formulas Using Range Finder
To Verify a Formula Using Range Finder
Formatting the Worksheet
To Change the Workbook Theme
To Format the Worksheet Titles
To Change the Background Color and Apply a
Box Border to the Worksheet Title
and Subtitle
To Apply a Cell Style to the Column
Headings and Format the Total Rows
To Format Dates and Center Data in Cells
To Apply an Accounting Number Format and
Comma Style Format Using the Ribbon
To Apply a Currency Style Format with a
Floating Dollar Sign Using the
Format Cells Dialog Box
To Apply a Percent Style Format and
Use the Increase Decimal Button
Conditional Formatting
To Apply Conditional Formatting
Conditional Formatting Operators
Changing Column Width and Row Height
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EX 2-7
EX 2-8
EX 2-8
EX 2-9
EX 2-9
EX 2-10
EX 2-10
EX 2-11
EX 2-13
EX 2-14
EX 2-14
EX 2-15

EX 2-16

EX 2-16

EX 2-18

EX 2-20

EX 2-21
EX 2-22
EX 2-22
EX 2-23
EX 2-24
EX 2-25

EX 2-26

EX 2-27
EX 2-28

EX 2-29

EX 2-30

EX 2-31
EX 2-31
EX 2-32
EX 2-34
EX 2-35
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To Change Column Width
To Change Row Height
Checking Spelling
To Check Spelling on the Worksheet
Additional Spelling Checker Considerations
Printing the Worksheet
To Change the Worksheet's Margins, Header,
and Orientation in Page Layout View
To Print a Worksheet
To Print a Section of the Worksheet
Displaying and Printing the Formulas Version
of the Worksheet
To Display the Formulas in the Worksheet
and Fit the Printout on One Page
To Change the Print Scaling Option
Back to 100%
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
In the Lab

MODULE THREE

Working with Large Worksheets,
Charting, and What-If Analysis
Objectives
Introduction
Project: Financial Projection Worksheet with
What-If Analysis and Chart
To Enter the Worksheet Titles and Apply
a Theme
Rotating Text and Using the Fill Handle
to Create a Series
To Rotate Text in a Cell
To Use the Fill Handle to Create a Series
of Month Names
Using the Auto Fill Options Menu
To Increase Column Widths
To Enter and Indent Row Titles
Copying a Range of Cells to a Nonadjacent
Destination Area
To Copy a Range of Cells to a
Nonadjacent Destination Area
Using the Paste Options Menu
Using Drag and Drop to Move or Copy Cells
Using Cut and Paste to Move Cells
Inserting and Deleting Cells in a Worksheet
To Insert a Row
Inserting Columns
Inserting Single Cells or a Range of Cells
Deleting Columns and Rows
To Enter Numbers with Format Symbols
To Enter the Projected Monthly Sales
To Enter and Format the System Date
Absolute versus Relative Addressing
To Enter a Formula Containing Absolute
Cell References
Making Decisions—The IF Function
To Enter an IF Function
To Enter the Remaining Formulas for January
To Copy Formulas with Absolute Cell
References Using the Fill Handle
To Determine Row Totals in Nonadjacent Cells

EX 2-35
EX 2-38
EX 2-39
EX 2-40
EX 2-41
EX 2-41

EX 2-42
EX 2-44
EX 2-45

EX 2-46

EX 2-47

EX 2-48
EX 2-49
EX 2-50
EX 2-51
EX 2-52
EX 2-53

EX 3-1
EX 3-1

EX 3-2

EX 3-5

EX 3-5
EX 3-5

EX 3-7
EX 3-8
EX 3-9
EX 3-10

EX 3-10

EX 3-11
EX 3-12
EX 3-12
EX 3-13
EX 3-13
EX 3-14
EX 3-15
EX 3-15
EX 3-16
EX 3-16
EX 3-17
EX 3-18
EX 3-20

EX 3-22
EX 3-24
EX 3-25
EX 3-26

EX 3-27
EX 3-28

Nested Forms of the IF Function
Adding and Formatting Sparkline Charts
To Add a Sparkline Chart to the Worksheet
To Change the Sparkline Style and Copy
the Sparkline Chart
To Change the Sparkline Type
Customizing Sparkline Charts
Formatting the Worksheet
To Assign Formats to Nonadjacent Ranges
To Format the Worksheet Titles
To Assign Cell Styles to Nonadjacent
Rows and Colors to a Cell
To Copy a Cell’s Format Using the
Format Painter Button
To Format the What-If Assumptions Table
Adding a Clustered Column Chart to the Workbook
To Draw a Clustered Column Chart on a
Separate Chart Sheet Using the
Recommended Charts Feature
To Insert a Chart Title
To Add Data Labels
To Apply Chart Filters
To Add an Axis Title to the Chart
To Change the Chart Style
To Modify the Chart Axis Number Format
To Remove Filters and Data Labels
Organizing the Workbook
To Rename and Color Sheet Tabs
To Reorder the Sheet Tabs
To Check Spelling in Multiple Sheets
To Preview and Print the Worksheet
Changing the View of the Worksheet
To Shrink and Magnify the View
of a Worksheet or Chart
To Split a Window into Panes
To Remove the Panes from the Window
To Freeze Worksheet Columns and Rows
To Unfreeze the Worksheet Columns and Rows
What-If Analysis
To Analyze Data in a Worksheet by
Changing Values
Goal Seeking
To Goal Seek
Insights
To Use the Smart Lookup Insight
Accessibility Features
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
In the Lab

MODULE ONE

Databases and Database Objects:
An Introduction
Objectives
Introduction
Project—Database Creation
Creating a Database
To Create a Database
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EX 3-64
EX 3-65
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To Create a Database Using a Template
The Access Window
Navigation Pane and Access Work Area
Determining Tables and Fields
Naming Tables and Fields
Determining the Primary Key
Determining Data Types for the Fields
Creating a Table in Datasheet View
To Modify the Primary Key
To Define the Remaining Fields in a Table
Making Changes to the Structure
To Save a Table
To View the Table in Design View
Checking the Structure in Design View
To Close the Table
To Add Records to a Table
Making Changes to the Data
Navigation Buttons
To Resize Columns in a Datasheet
To Create a Table in Design View
Correcting Errors in the Structure
Populating the Patients Table
To Close the Table
To Resize Columns in a Datasheet
Importing Additional Access Database
Tables into an Existing Database
Additional Database Objects
Creating Queries
To Use the Simple Query Wizard to
Create a Query
Using Queries
Creating Forms
To Create a Form
Using a Form
To Create a Report Using the Report Wizard
Using Layout View in a Report
Database Properties
Special Database Operations
Backup and Recovery
Compacting and Repairing a Database
Additional Operations
To Exit Access
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
In the Lab

MODULE TWO

Querying a Database
Objectives
Introduction
Project — Querying a Database
Creating Queries
To Create a Query in Design View
To Add Records to the Database
To Add Fields to the Design Grid
Determining Criteria
Running the Query
To Use Text Data in a Criterion
Using Saved Queries
Wildcards
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AC 1-36
AC1-37
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AC1-39
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AC1-40
AC1-41
AC 1-42
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To Use a Wildcard
To Use Criteria for a Field Not Included
in the Results
Creating a Parameter Query
To Create and View a Parameter Query
To Use a Parameter Query
To Use a Number in a Criterion
Comparison Operators
To Use a Comparison Operator in a Criterion
Using Compound Criteria
To Use a Compound Criterion Involving AND
To Use a Compound Criterion Involving OR
Special Criteria
Sorting
To Clear the Design Grid
To Import a Table
To Sort Data in a Query
To Omit Duplicates
To Sort on Multiple Keys
To Create a Top-Values Query
Joining Tables
To Join Tables
To Change Join Properties
To Create a Report from a Query
To Print a Report
Creating a Form for a Query
To Create a Form for a Query
Using a Form
Exporting Data from Access to Other Applications
To Export Data to Excel
Text Files
Adding Criteria to a Join Query
To Restrict the Records in a Join
Calculations
To Use a Calculated Field in a Query
To Change a Caption
To Calculate Statistics
To Use Criteria in Calculating Statistics
To Use Grouping
Crosstab Queries
To Create a Crosstab Query
Customizing the Navigation Pane
To Customize the Navigation Pane
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
In the Lab

MODULE THREE

Maintaining a Database
Objectives
Introduction
Project — Maintaining a Database
Updating Records
To Create a Split Form
To Use a Form to Add Records
To Search for a Record
To Update the Contents of a Record
To Delete a Record
Filtering Records
To Use Filter By Selection
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To Toggle a Filter

To Clear a Filter

To Use a Common Filter

To Use Filter By Form

To Use Advanced Filter/Sort

Filters and Queries
Changing the Database Structure

To Change a Number Field Size in Design View

To Add a New Field

To Create a Lookup Field

To Add a Multivalued Field

To Add a Calculated Field

To Save the Changes and Close the Table
Mass Changes

To Use an Update Query
Validation Rules

To Change a Field Size

To Specify a Required Field

To Specify a Range

To Specify a Default Value

To Specify a Collection of Legal Values

To Save the Validation Rules, Default

Values, and Formats

Updating a Table That Contains Validation Rules
Making Additional Changes to the Database

To Change the Contents of a Field

To Use a Lookup Field

To Use a Multivalued Lookup Field

AC3-10
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AC3-11
AC 3-12
AC3-13
AC3-14
AC3-15
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AC3-19
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AC 3-22
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AC 3-25
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AC 3-28
AC 3-28
AC 3-29
AC 3-29
AC3-30
AC 3-30

AC3-31
AC3-32
AC3-34
AC3-34
AC 3-34
AC 3-35

Changing the Appearance of a Datasheet
To Include Totals in a Datasheet
To Remove Totals from a Datasheet
To Change Gridlines in a Datasheet
To Change the Colors and Font in a Datasheet
Using the Datasheet Formatting Dialog Box
To Close the Datasheet without Saving
the Format Changes
Multivalued Fields in Queries
To Include Multiple Values on One Row
of a Query
To Include Multiple Values on Multiple
Rows of a Query
To Test an Existing Query with a
Multivalued Field
Referential Integrity
To Specify Referential Integrity
Effect of Referential Integrity
To Use a Subdatasheet
Handling Data Inconsistency
Ordering Records
To Use the Ascending Button to Order Records
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
In the Labs
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Getting to Know
Microsoft Office Versions

Cengage is proud to bring you the next edition of Microsoft Office. This
edition was designed to provide a robust learning experience that is not
dependent upon a specific version of Office.

Microsoft supports several versions of Office:

e Office 365: A cloud-based subscription service that delivers
Microsoft’s most up-to-date, feature-rich, modern productivity tools
direct to your device. There are variations of Office 365 for business,
educational, and personal use. Office 365 offers extra online storage
and cloud-connected features, as well as updates with the latest
features, fixes, and security updates.

o Office 2019: Microsoft’s “on-premises” version of the Office apps,
available for both PCs and Macs, offered as a static, one-time
purchase and outside of the subscription model.

e Office Online: A free, simplified version of Office web applications
(Word, Excel, PowerPoint, and OneNote) that facilitates creating and
editing files collaboratively.

Office 365 (the subscription model) and Office 2019 (the one-time pur-
chase model) had only slight differences between them at the time this
content was developed. Over time, Office 365’s cloud interface will con-
tinuously update, offering new application features and functions, while
Office 2019 will remain static. Therefore, your onscreen experience may
differ from what you see in this product. For example, the more advanced
features and functionalities covered in this product may not be available
in Office Online or may have updated from what you see in Office 2019.

For more information on the differences between Office 365, Office 2019,
and Office Online, please visit the Microsoft Support site.

Cengage is committed to providing high-quality learning solutions for
you to gain the knowledge and skills that will empower you throughout
your educational and professional careers.

Thank you for using our product, and we look forward to exploring the

future of Microsoft Office with you!
Getting to Know Microsoft Office Versions
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Using SAM Projects
and Textbook Projects

SAM and MindTap are interactive online platforms designed to transform
students into Microsoft Office and Computer Concepts masters. Practice
with simulated SAM Trainings and MindTap activities and actively apply
the skills you learned live in Microsoft Word, Excel, PowerPoint, or Access.
Become a more productive student and use these skills throughout

your career.
If your instructor assigns SAM Projects:
1. Launch your SAM Project assignment from SAM or MindTap.

2. Click the links to download your Instructions file, Start file, and
Support files (when available).

3. Open the Instructions file and follow the step-by-step instructions.

4. When you complete the project, upload your file to SAM or MindTap
for immmediate feedback.

To use SAM Textbook Projects:
Launch your SAM Project assignment from SAM or MindTap.

2. Click the links to download your Start file and Support files
(when available).

3. Locate the module indicated in your book or eBook.

4, Read the module and complete the project.

-
4 .
w“ Open the Start file you downloaded.

-1, Save, close, and upload your completed project to receive
w“ immediate feedback.

. _J

IMPORTANT: To receive full credit for your Textbook Project, you must
complete the activity using the Start file you downloaded from SAM

or MindTap.
Using SAM Projects and Textbook Projects
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Creating and
Modifying a Flyer

Objectives
After completing this module, you will be able to:
e Start and exit Word ¢ Insert and format a picture
* Enter text in a Word document * Add a page border
* Adjust margins * Change document properties
* Check spelling and grammar as you * Open and close a document

work in a document .
e Correct errors and revise a document

* Save a document * Cut, copy, and paste text

* Format text, paragraphs, and document

* Print a document
elements

* Undo and redo commands or actions * Use Word Help

What Is Word?

Microsoft Word, or Word, is a full-featured word processing app that allows you to
create professional-looking documents and revise them easily. With Word, you can
create business, academic, and personal documents, including flyers, research papers,
letters, memos, resumes, reports, mailing labels, and newsletters.

Word has many features designed to simplify the production of documents and
add visual appeal. Using Word, you easily can change the shape, size, and color of
text. You also can include borders, shading, tables, pictures, charts, and other objects
in documents. While you are typing, Word performs many tasks automatically. For
example, Word detects and corrects spelling and grammar errors in several languages.
Word’s thesaurus allows you to add variety and precision to your writing. In addition
to formatting text as you type, such as headings, lists, fractions, borders, and web
addresses, Word includes a great deal of predefined text and many predefined objects
and document types. Word also provides tools that enable you to create webpages and
save the webpages directly on a web server.

To illustrate the features of Word, this book presents a series of projects that
use Word to create documents similar to those you will encounter in business and
academic environments.
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Introduction

"To convey a message or announcement to employees or staff members, campus or
school students, or the community or public, you may want to create a flyer. You then
can post the flyer in a location targeted to your intended audience, such as on an
employee bulletin board or in an office cubicle, at a kiosk, or on a hallway wall. You
may also see flyers on webpages, on social media, or in email messages.

Project: Flyer with a Picture

Businesses create flyers to gain attention for a message or an announcement. Flyers,
which usually are a single page in length, are an inexpensive means of reaching an
audience. Many flyers, however, go unnoticed because they are designed poorly.

The project in this module follows generally accepted design guidelines and uses
Microsoft Word to create the flyer shown in Figure 1-1. This colorful, eye-catching flyer
is intended to convey proper handwashing techniques to food service employees at a
campus or school cafeteria. The flyer, which will be hung above every sink in the kitchen
and restroom areas, contains a digital picture of an employee washing his hands. The
headline on the flyer is large and colorful to draw attention into the text. The body copy

page border

numbered

WASH YOUR HANDS!

H

headline

list

e Before, during, and after preparing food
s After eating, coughing, sneezing, or using a tissue

Washing your hands with soap and water can decrease)
™~ outbreaks of foodborne illness because it can prevent
spreading germs from your hands to food.
How?
1. Wet hands with clean, running water, and apply soap. } @
2.Lather hands (palms, backs, below nails, between fingers,
around thumbs) by rubbing them together with the soap.
3. Scrub hands for at least 20 seconds.
4.Rinse soap off hands under clean, running water.
5.Dry hands well using a clean towel or an air dryer. J
digital
picture of
handwashing
When?

ALPA PROD/Shutterstock.com

bulleted list

>4 & After using or assisting someone in the restroom
» After touching an animal, animal feed, or animal waste
o After handling dirty equipment or garbage

body copy

Visit www.foodworkers.com for additional handwashing tips.

1 signature line

WD 1-2 Figure 1-1
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below the headline briefly describes the purpose of handwashing, along with a numbered
list that highlights how to wash hands and a bulleted list that concisely describes when to
wash hands. The signature line of the flyer identifies a website that employees can visit for
additional handwashing tips. Some words in the flyer are in a different color or further
emphasized so that they stand apart from the rest of the text on the flyer. Finally, the page
border nicely frames and complements the contents of the flyer.

In this module, you will learn how to create the flyer shown in Figure 1-1. You
will perform the following general tasks as you progress through this module:

1. Start and use Word. 4. Insert and format a picture in the flyer.
2. Enter text in a document. 5. Enhance the layout of the flyer on the page.
3. Format the text in the flyer. 6. Correct errors and revise text in the flyer.

Starting and Using Word

"To use Word, you must instruct the operating system (i.e., Windows) to start the app. BTW
The following sections start Word, discuss some elements of the Word window, and Resolution

perform tasks to specify Word settings. For information about how
to change a computer’s

If you are using a computer or device to step through the project in this module  resolution, search for ‘change
and you want your screen to match the figures in this book, you should change your resolution’ in your operating

screen’s resolution to 1366 x 768. system’s help files.

To Start Word and Create a Blank Document

The following steps, which assume Windows is running, start Word and create a blank document based on
a typical installation. Why? You will use Word to create the flyer in this module. You may need to ask your instructor
how to start Word on your computer or device.

o ST ¥ Click the Start button on

the Windows taskbar to display _ /

the Start menu. Note: To help you locate screen

elements that are referenced

§ What is a menu? in tbhe step ins;ructions, ZUChh
. . as buttons and commands, t is
| A menu contains a list of related . A book uses red boxes to point
items, including commands, apps, n - 1O these screen elements
programs, and folders. Each
command is a menu A -
: list of apps B -
item that performs installed on -
a specific action, computer '
. . appears on R
such as saving a file Start menu -
.. above Start "
or obtaining help. A B ..
folder is a named " -

location on a storage
medium that usually contains
related documents.

%
-

o -

o If necessary, scroll through the list
of apps on the Start

P i - Windows

& Type here to search -] —>

menu until the Word taskbar
app name appears P Fiqure 1-2
(Figure 1-2). 9

< | What if my Word app is in a folder?
o | Click the appropriate folder name to display the contents of the folder.

WD 1-3
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12

e Click Word on the Start menu to start Word and display the Word start screen (Figure 1-3).

Word start
«—| screen
Word is running Wosd owheme & g
Good afternoon list of predefined documents,
or templates — your list may
differ
&
Blank document Bk heCurmmrdt Welcome to Word  2* Shagle spaced [blank) Ohacarhogpcal Rutmrnt Croathrs insiome, desig. Creative comver lethe, 4
thumbnail, or
miniature image i s

Recent Pinned Shated with Me

Nou havent opaned sy docusnamts recently. Chck Dpon 10 bicwie 104 8 document

More focumeny

list of recently opened
documents — your list may
differ

Figure 1-3

13

e Click the Blank document thumbnail on the Word start screen to create a blank document in the Word window
(Figure 1-4).

e |f the Word window is not maximized, click the Maximize button next to the Close button on the title bar to
maximize the window.

title of blank -
Document1 scirveard] - Woed

iske Home nLent Draw Dervgn Layout Feferences htgasmip. fpvrs e Help b Tell mq nhat you want t0 do % Share » Cogfiments
| & ] S Il H
" i iBed, A A Hp == Aan ’ : P
E| AdB aasec . |
Paste 1 ' . A . Bz imi e
o o foumd Vb Tilrdxx A-£-4- ESS s o B | - 'g'at);'m'zﬁ ¢ Close button
e o —s . el @ETIefS closes an
Rt 5 o : \asaguaph : dei " .
Lo ¥ to a Restore open window
Down button
because window
is maximized
blank I

document
created \ |

Print Layout button

Windows Windows taskbar displays is sel_ected when you
search Word app button, first install Word
box indicating Word is running

Pge 100

o Type here 10 search

Figure 1-4
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What is a maximized window?
A maximized window fills the entire screen. When you maximize a window, the Maximize button changes to a
Restore Down button.

<
o3
o4

©

Word Module 1

e If the Print Layout button is not selected, click it so that your screen layout matches Figure 1-4.

What is Print Layout view?
The default (preset) view in Word is Print Layout view, which shows the document on an image of a sheet of
paper in the document window.

Q&A

Other Ways

1. Type app name in Windows search box, click app name in results list 2. Double-click Word icon on desktop, if one is present

The Word Window BTW

The Word Window
The Word window consists of a variety of components to make your work more  The modules in this book

efficient and documents more professional. These include the document window begin with the Word window
d 1oth 1 ts. d di he task £ . b appearing as it did at the

and several other elements, depending on the task you are performing: scro ar(s), initial installation of the

status bar, ribbon, Tell Me box, Quick Access Toolbar, Mini toolbar, shortcut menus, software. Your Word window

KeyTips, and Microsoft Account area. Most of these are common to other Microsoft may look different depending

on your screen resolution and

Office apps; others are unique to Word. The following sections briefly describe these other Word settings.

elements; others are discussed as they appear in the Word window.

You view or work with a document on the screen through a document window,
which is a window within Word that displays all or part of an open document (Figure 1-5).
In the document, the insertion point is a blinking vertical line that appears when you
click in the document and indicates where new text, pictures, and other objects will be
inserted. As you type, the insertion point moves to the right, and when you reach the end
of a line, it moves down to the beginning of the next line. The pointer is a small symbol
on the screen that becomes different shapes depending on the task you are performing
in Word and the pointer’s location on the screen. You move the pointer with a pointing
device, such as a mouse or touchpad. The pointer in Figure 1-5 is the shape of an I-beam.

Scroll Bar You use scroll bars, which appear at the right and bottom edges of the
document window, to view documents that are too large to fit on the screen at once.
At the right edge of the document window is a vertical scroll bar. If a document is too
wide to fit in the document window, a horizontal scroll bar also appears at the bottom
of the document window. On a scroll bar, the position of the scroll box reflects the
location of the portion of the document that is displayed in the document window; you
can drag the scroll box, or click above or below it, to scroll through or display different
parts of the document in the document window. A scroll arrow is a small triangular up
or down arrow that is located at each end of a scroll bar; you can click the scroll arrows
to scroll through the document in small increments.

Status Bar The status bar, located at the bottom of the document window above
the Windows taskbar, presents information about the document, the progress of
current tasks, and the status of certain commands and keys; it also provides controls
for viewing the document, such as zoom controls. As you type text or perform certain
commands, various indicators and buttons may appear on the status bar.

The left side of the status bar in Figure 1-5 shows the current page followed
by the total number of pages in the document, the number of words in the document,
and an icon to check spelling and grammar. The right side of the status bar includes
buttons and controls you can use to change the view of a document and adjust the size
of the displayed document.
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WASH YOUR HANDS!

Washing your hands with soap and water can decrease
outbreaks of foodborne illness because it can prevent
spreading germs from your hands to food.
1, Wet hands with clean, running water, and apply soap.
2 me% backs, tnlnwrmﬂs bezwem ﬁngéra

stored
document

Normal is the
default style

£ Tell ma what o s
:TII{'. CoaaMTde=(2_-(X A" Aa "5:" L8 aamca| aBbcd AaBbC Aamece Adl o
o romuraey B U -end A2 io | Tl [ Thiatanc. lesfieg] tusbogl  Tam Goes
Owberst to L3 » -
When?
» Before, during. and after prepatin
+ After eating, coughing, sneezing, Washing your hands with soap and water can decrease | (I-beam)
. Aﬁerucmgnrasssungsonmone S : . i o e
- After ouching an animal, animl outbreaks of foodborne illness because it can prevent
o After handling dirty equip ¢ spreading germs from your hands to food,
Visit www. foodworkers.com for adgdy How? I
number of || number of 1, Wet hands with clean, running water, '"Sertt'°" pap. | adjusts size
oin B
pages in words in 2. Lather hands (palms, backs, below nail P gf dlsplayted £
ocumen
document || document around thumbs) by rubbing them together with the soap. | 9
ol
document window '—> 3.Scrub hands for at least 20 seconds. I o
. . Print Layout Sdrell] elfiRety g
4.Rinse soap off hands under clean, running watg .. .o 2z
* . =}
‘Spelling and Grammar (S Well using a clean towel or an air dr] default view S
Check’ icon I \ =
S L] = h | £
O Type bare 10 searcn 1] %
Figure 1-5

Ribbon The ribbon, which is a horizontal strip located near the top of the Word
window below the title bar, is the control center in Word that contains tabs of grouped
commands that you click to interact with Word (Figure 1-6a). Each tab contains a
collection of groups, and each group contains related commands. The ribbon provides
easy, central access to the tasks you perform while creating a document.

‘Ribbon Display
Options’ button

Home tab

Tell Me box

Comments ()

D =

. Paplaci

& T Hormal | T o Spec..  Haed furmg B Vg gaders Tie .
S . - o S y ] e 2
@ Solest~

‘Collapse the
Ribbon’ button

Figure 1-6a
BTW When you start Word, the ribbon displays several main tabs, also called default
Pointer or top-level tabs (i.e., File, Home, Insert, Draw, Design, Layout, References, Mailings,

If you are using a touch

screen, the pointer may not
appear on the screen as you
perform touch gestures. The
pointer will reappear when

you begin using the mouse.

Review, View, and Help). (Note that depending on the type of computer or device you are
using, the Draw tab may not appear.) The Home tab, also called the primary tab, contains
the more frequently used commands. The tab currently displayed is called the active tab.
To display more of the document in the document window, some users prefer to
minimize the ribbon, which hides the groups on the ribbon and displays only the main tabs
(Figure 1-6b). To minimize the ribbon, click the ‘Collapse the Ribbon’ button or click the
‘Ribbon Display Options’ button on the title bar and then click Show Tabs on the menu. To

use commands on a minimized ribbon, sometimes called a simplified ribbon, click the tab
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that you wish to expand. To expand the ribbon, double-click a tab, click the ‘Pin the ribbon’
button on an expanded tab, or click the ‘Ribbon Display Options’ button on the title bar
and then click ‘Show Tabs and Commands’ on the menu.

Word Module 1

e Home  Weam Orew DeBgn Liyow Releresces MaBngs Review Ve WD 0 Tell ma WAt pou Wi to 80 & share O commens (2

Fgure 1-66

Each time you start Word, the ribbon appears the same way it did the last time
you used Word. The modules in this book, however, begin with the ribbon appearing
as it did at the initial installation of the software.

In addition to the main tabs, Word displays other tabs, called tool tabs or
contextual tabs, when you perform certain tasks or work with objects such as pictures
or tables. If you insert a picture in the document, for example, the Picture Tools tab
and its related subordinate Format tab appear, collectively referred to as the Picture
Tools Format tab (Figure 1-7). When you are finished working with the picture, the
Picture Tools Format tab disappears from the ribbon. Word determines when tool tabs
should appear and disappear based on tasks you perform. Some tool tabs, such as the
Table Tools tab, have more than one related subordinate tab.

Picture Tools
gallery scroll Format tab
arrows

e Home imer] [ Dwiign Layout Relorence Madng Reverw Rk Help Format L Tell ma what you nant to do & Share = Commenis @
- B Coler * R 2 Pictime Beeder - e Positic » e
[ T T ol ol i ol o a8 . yse Effpets . ~ Wrap Tet = 0 Sefection Pane 9=
Permoe Commctaony . - o Crep 3944 -
[N ] - ) Transparmaey = [S1+ - - tuse Lot - bu.-‘“ . 5 / \
> f
pre] e Bictizs Unics Anarce ("3 2
[\

in-ribbon More e~ text”box
gallery button scroll arrows
button

Figure 1-7

Picture Tools Format tab
is one of many tool tabs
that appear automatically
depending on task you

perform

Items on the ribbon include
buttons, boxes (text boxes, check
boxes, etc.), and galleries (shown
in Figure 1-7). A gallery is a set of
choices, often graphical, arranged
in a grid or in a list that you can
browse through before making a
selection. You can scroll through
choices in an in-ribbon gallery
by clicking the gallery’s scroll
arrows. Or, you can click a gallery’s
More button to view more gallery
options on the screen at a time.

Some buttons and boxes

Malingy

Frawrs Ve Help

Format B Tell me what jou want 1o do

o i o o~ B~ [ B~ E & #unwer| @ you move pointer from

. : _— . one gallery option to next,
—_— Eg— Word shows Live Preview

E @ ] e o= of style in document, so e
that you can see effect of

option in document before

selecting it

'3

= picture changes as
—— —-—-,,_:“--H you point to style in
: the gallery

/

have arrows that, when clicked, licking More button
. displays these additional | \
also display a gallery; others always gallery options '

cause a gallery to be displayed
when clicked. Most galleries
support Live Preview, which is a
feature that allows you to point to
a gallery choice and see its effect in
the document — without actually
selecting the choice (Figure 1-8).

ALPA PROD/Shutterstock.com

Figure 1-8
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image of Some commands on the ribbon display an image to help you

ﬂéﬁff o remember their function. When you point to a command on the ribbon,
identify all or part of the command glows in shades of gray, and a ScreenTip

button appears on the screen. A ScreenTip is a label that appears when you
pointer ::”‘:‘p““ point to a button or other on-screen object, which may include the name,
on g oy

Paste
arrow

— purpose, or keyboard shortcut for the object and a link to associated help
ScreenTip

Paste (Crie V)

; ; o forPaste | topics, if any exist (Figure 1-9).
— S ki Some groups on the ribbon have a small arrow in the lower-right
corner, called a Dialog Box Launcher, that when clicked, displays
Figure 1-9 a dialog box or opens a pane with additional options for the group
(Figure 1-10). When presented with a dialog box, you make selections
and must close the dialog box
before returning to the document.
A pane, in contrast to a dialog box,
is a window that can remain open
and visible while you work in the

clicking Dialog
Box Launcher in
Clipboard group
opens Clipboard
pane

¥ Favrnan Dumater

Chpeamn

e ' & document and provides additional
= v x 5 [ - .
Clipboard - — options.
ol : I - T -
T e clicking Dl_alog Box - Headngs ake :
Launcher in Font o N Ttms | Emm Tell Me Box The Tell Me

o i group displays
Font dialog box

box, which appears to the right

Farn genee Wt sty
B i iooem— of the tabs on the ribbon, is a
Cl——. £ st com text box that helps you to find a
() Dsunge srasmesupn [ im o K
oo DOlzmoses command in Word or access the
owen Word Help system (Figure 1-11).
Calibry

As you enter text in the Tell Me
box, the word-wheeling feature
displays search results that are
refined as you type. For example,
if you want to insert a picture in
Figure 1-10 idocum('ent, you can type the text
Quick Access insert picture” in the Tell Me box

Ib .
o LTookar and then select the appropriate

command.

Quick Access Toolbar The
Quick Access Toolbar, located
initially (by default) above the
ribbon at the left edge of the title
bar, is a customizable toolbar
that contains buttons you can
click to perform frequently

BTW Figure 1-11 used commands (shown in
Mouse Mode Figure 1-11). The commands

The figures in this book use  on the Quick Access Toolbar always are available, regardless of the task you are
"[\:I)thjli)eusrT;or(:]Zd-go a’i‘é'lictie performing. The Touch/Mouse Mode button on the Quick Access Toolbar allows
Touch/Mouse Mode’ button  you to switch between Touch mode and Mouse mode. If you primarily are using

on the Quick Access Toolbar  touch gestures, Touch mode will add more space between commands on menus and

and then dlick Mouse onthe - 13 the ribbon so that they are easier to tap. While touch gestures are convenient
Touch/Mouse Mode menu. If

Thet = 10 magy thime (3t Tee Serment SScument Teme Jrimel wisch fomt we D Uted

Setdo Drivudt st fiinch E Caneni

¥ Ferwst Passerr

ChoRosa

Touch/Mouse ‘Customize
Mode button Quick Access i
Toolbar’ button et bk

search results

you are using Touch mode. ways to interact with Worq, not all features are supporFed when you are using
you might notice that the Touch mode. If you are using a mouse, Mouse mode will not add the extra space
function or appearance of between buttons and commands. The modules in this book show the screens in

your touch screen in Word
differs slightly from this
module’s presentation.

Mouse mode.
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You can add other commands to or delete commands from the Quick Access

Toolbar so that it contains the commands you use most often. To do this, click the

‘Customize Quick Access Toolbar’ button on the Quick Access Toolbar and then select

the commands you want to add or remove. As you add commands to the Quick Access

Toolbar, its length may interfere with the document title on the title bar. For this

reason, Word provides an option of displaying the Quick Access Toolbar below the BTW

ribbon on the Quick Access Toolbar menu. Turning Off the Mini
Each time you start Word, the Quick Access Toolbar appears the same way it did ~ Toolbar

the last time you used Word. The modules in this book, however, begin with the Quick f you do not want the

. .. e 1. . Mini toolbar to appear,
Access Toolbar appearing as it did at the initial installation of the software.

click File on the ribbon to

Mini Toolbar and Shortcut Menus The Mini toolbar, which appears next to open Backstage view, click
Options in Backstage view,

selected text, contains the most frequently used text formatting commands (which are if necessary, click General
those commands related to changing the appearance of text in a document). If you do ~ (Options dialog box), remove
not use the Mini toolbar, it disappears from the screen. The buttons, arrows, and boxes the check mark from the

the Mini b d di heth o Touch d M ‘Show Mini Toolbar on
on the Mini toolbar vary, depending on whether you are using Touch mode or Mouse  gjection’ check box, and
mode. To use the Mini toolbar, move the pointer into the Mini toolbar. then click OK.

All commands on the Mini toolbar
also exist on the ribbon. The purpose of
the Mini toolbar is to minimize hand or
mouse movement. For example, if you

want to use a command that currently is

Word Module 1

A G
Mo
. Mo

¥ Ferma P aman

not displayed on the active tab, you can Ogpems - ' T Mini
use the command on the Mini toolbar — / toolbar
instead of switching to a different tab to commands on L il [
use the command. Aoonbbon” | meamy =
A shortcut menu, which appears Lm
when you right-click an object, is a list of Pt Oy
frequently used commands that relate to -
the right-clicked object. When you right- 3 1
i

click selected text, for example, a shortcut
menu appears with commands related

to text. If you right-click an item in the
document window, Word displays both
the Mini toolbar and a shortcut menu
(Figure 1-12).

TR Tismginte shortcut
menu

Figure 1-12

KeyTips If you prefer using the keyboard instead of the mouse, you can press

ALT on the keyboard to display KeyTips, which are labels that appear over each

tab and command on the ribbon (Figure 1-13). To select a tab or command using

the keyboard, press the letter or number displayed in the KeyTip, which may cause

additional KeyTips related to the selected command to appear. For example, to select

the Bold button on the Home tab, press ALT, then press H, and then press 1. To

remove the KeyTips from the screen, press ALT or ESC until all KeyTips disappear, "
Microso

or click anywhere in the Word window. PERIRERE

Microsoft Account Area In the
Microsoft Account Area (shown in
Figure 1-13), you can use the Sign
in link to sign in to your Microsoft
account. Once signed in, you will KeyTips appear when you .
see your account information. B AT | e Figure 1-13
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To Display a Different Tab on the Ribbon

When you start Word, the ribbon displays 11 main tabs: File, Home, Insert, Draw, Design, Layout,
References, Mailings, Review, View, and Help. (Note that depending on the type of computer or device you are
using, the Draw tab may not appear.) The tab currently displayed is called the active tab. To display a different tab
on the ribbon, you click the tab. The following step displays the View tab, that is, makes it the active tab. Why?
When working with Word, you may need to switch tabs to access other options for working with a document or to verify settings.

e Click View on the ribbon to display the View tab (Figure 1-14).

Why did the groups on the ribbon change?
When you switch from one tab to another on the ribbon, the groups on the ribbon change to show commands
related to the selected tab.

<
o3
(o4

Touch/Mouse
Mode button

100% button
sets zoom
level to 100%

Ruler check
box not
selected

Print Layout
button
selected

View tab
selected

Fie Home Insert Draw Dessgn Liry0 References Review Ml H 4 Share = Comments R_-“)
ar Outhne 1 Puder b One P 3| ¥
EBIEHE3 Boe [ JENEm Q [y Dovatese E [
= [Elonh St T L Guienes . ] Misnpie Pagyes
Read Pt Web Learming  Wartical  Sude Zoom 100% .. Macros Propertes
Mode Layoul Layout Tooks 10 Sucbe Naagation Pane « < Page Wadth .
e mmgriter  Page Migwesmont Show Ioom Magres  SharePoint -
\ Show T\ Zoom
group group
Views
group
T —, | e
groups on ribbon change to [l Leymus ?88‘:2 fevel
show commands related to button
viewing document, because selected B
View tab now is active tab
Pagelof 1 Dwords : B = - ] + 100%

Figure 1-14

12)

e Verify that the Print Layout button (View tab | Views group) is selected. (If it is not selected, click it to ensure the
screen is in Print Layout view.)

e Verify that the zoom level is 100% on the status bar. (If it is not, click the 100% button (View tab | Zoom group) to
set the zoom level to 100%.)

e Verify that the Ruler check box (View tab | Show group) is not selected. (If it is selected, click it to remove the
selection because you do not want the rulers to appear on the screen.)

Experiment

e Click the other tabs on the ribbon to view their contents. When you are finished, click Home on the ribbon to
display the Home tab.

o Verify that Normal (Home tab | Styles group) is selected in the Styles gallery (shown in Figure 1-5). (If it is not
selected, click it so that your document uses the Normal style.)

What is the Normal style?
When you create a document, Word formats the text using a particular style. The Normal style is the default style
that is applied to all text when you start Word.

<
o3
(o4

e If you are using a mouse, verify that you are using Mouse mode so that your screens match the figures in this book
by clicking the Touch/Mouse Mode button on the Quick Access Toolbar (shown in Figure 1-5) and then, if necessary,
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clicking Mouse on the menu (if your Quick Access Toolbar does not display the Touch/Mouse Mode button, click
the Customize Quick Access Toolbar button on the Quick Access Toolbar and then click Touch/Mouse Mode on the
menu to add the button to the Quick Access Toolbar).

Word Module 1

To Adjust the Margins

Word is preset to use standard 8.5-by-11-inch paper, with 1-inch top, bottom, left, and right margins. The
flyer in this module uses .5-inch top, bottom, left, and right margins. Why? You would like more text to fit from left
to right and top to bottom on the page.

When you change the default (preset) margin settings, the new margin settings affect every page in the
document. If you wanted the margins to affect just a portion of the document, you would divide the document
into sections (discussed in a later module), which enables you to specify different margin settings for each
section. The following steps change margin settings.

Page Setup
®

e Click Layout on the

Layout tab

ribbon to display the 'I;Aui::%i:s NE wome  wian Daw Desgn eowt  fele| depending on previous
iy margin usage, your
LaYOUt tab. D r."\ D D et gallery may not have

« L Mornbsers ©

Margint Cesstation  Sov  Cabamins this setting

e Click the Margins g
Lawt Cunlom Setting Firsgagh
button (LaYOUt current prs T 1" top margin is visible
tab | Page Setup margin \4 in document above
setting Mormd insertion point

group) to display

O O] B'E!v

the Margins gallery —
. |"\ insertion
(Flgure 1-1 5) point
Narrow Sadvics .
margin
setting
g e
I I ey ic 1" left margin is visible
B - in document to left of
" insertion point
Margins
gallery Custom Margins command
displays Margins tab in
Page Setup dialog box
e Figure 1-15
e Click Narrow in the Margins
gallery to change the margins fle  Home imet Oram Design Lwout Aeleresces  Madags  Review Veew  Help O Tell me what yos mant )
to the specified settings 0 [E,! ) Ei et Spcng ~ A s
g UMb = i 0 s Zedsstp o i
(ngre 1_16) Morgin Oviesiation, S - Cokummg ER one | E w0 iR e ‘_ s-r:
. . . Lo i, . P ph . Asvng
SB What if the margin settings | want e — =
o/ are not in the Margins gallery? ~———— o lopmargnis
You can click Custom Margins in l~—_ above insertion point
the Margins gallery and then enter -

point

your desired margin values in the 4
top, bottom, left, and right boxes
in the Page Setup dialog box.

.5" left margin is visible in
document to left of insertion point

Figure 1-16

‘ Other Ways

‘ 1. Position pointer on margin boundary on ruler; when pointer changes to two-headed arrow, drag margin boundary on ruler

Copyright 2020 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s).
Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.



WD 1-12 Word Module 1 Creating and Modifying a Flyer

BTW

Character Widths
Many word processing
documents use variable
character fonts, where some
characters are wider than
others; for example, the letter

W is

wider than the letter i.

To Type Text

Entering Text in a Document

The first step in creating a document is to enter its text. With the projects in this book,
you enter text by typing on the keyboard. By default, Word positions text you type

at the left margin. In a later section of this module, you will learn how to format, or
change the appearance of, the entered text.

Q&A

"To begin creating the flyer in this module, type the headline in the document window. Why? The headline is
the first line of text in the flyer: The following steps type the first line of text in the document.

1)

Type Wash Your Hands! asthe headline (Figure 1-17).

What if | make an error while typing?
You can press BACKSPACE until you have deleted the text in
error and then retype the text correctly.

What is the purpose of the ‘Spelling and Grammar Check’
icon on the status bar?

The ‘Spelling and Grammar Check’ icon displays either a
check mark to indicate the entered text contains no spelling
or grammar errors, or an X to indicate that it found potential
errors. Word flags potential errors in the document with
squiggly, dotted, or double underlines that appear in a
variety of colors. Later in this module, you will learn how to
fix or ignore flagged errors.

12)

e Press ENTER to move the insertion point to the beginning of the next line

< | Why did blank space appear between the headline and the insertion

(=4

(Figure 1-18).

point?

Each time you press ENTER, Word creates a new paragraph and inserts

File

oM et Draw Detign

0 & 0O B = _

b B phenatan -

Margeni Orevtateon  Sge  Colurmen

Fage Setup

image of sheet of paper
on screen because screen
is in Print Layout view

#

m Feferenced Mobduben .

Pndert Speung

e 1 £ Before

= hghe © Shbhee 8

N insertion point
moves to the
right as you type
Warsh Your Hands —

‘\I text typed

pointer’s shape changes depending
on task you are performing in Word
and pointer’s location on screen

—

number of
words in

document

‘Spelling and Grammar Check’ icon
contains a check mark, indicating the
entered text contains no spelling or

\

Papetol )

2 /

) wartn

grammar errors

Figure 1-17

blank space between the two paragraphs. Later in this module, you will

learn how to increase and decrease the spacing between paragraphs.

blank space
automatically Wash Your Hands!
Eser‘ted — insertion
etween |<— point moved
paragraphs to next line
Figure 1-18

CONSIDER THIS

How do you use the touch keyboard with a touch screen?

To display the on-screen touch keyboard, tap the Touch Keyboard button on the Windows taskbar. When finished using the
touch keyboard, tap the X button on the touch keyboard to close the keyboard.
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